Chapter 2

Getting Started with
an MEP Project

Learning Objectives

After completing this chapter, you will be able to:

* Understand the essentials of an MEP Project

e Start a new project

* Set the units of various measurement parameters in a project
* Understand the use of Project Templates

* Learn the concept of snaps, dimensions, and object snaps

* Use the Options dialog box

* Save a project

* Close and exit an MEP Project

* Open an existing project
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OVERVIEW OF AN MEP PROJECT

In Revit, a project is delivered as a single model with an integration of various disciplines
such as Architecture, MEP, and Structure. This means that the project file that you create will
contain all the information related to building design from geometry to various construction
documentations such as schedules and legends. Generally, this information includes the
details of the building elements like walls, doors, windows, beams, columns, ducts, pipes,
equipment, fixtures, and others. The information in the project also includes different views
of the project, working drawings created from the building elements, and the documentation
related to design of the model.

In Revit, you can generate different views such as plan, elevation, and sections from a 3D
building project. These views are associative with each other. This means when you change
the building design in one view, it is propagated throughout the project.

In Revit, the project file in which you will create the MEP project is based on a Revit Template
File (.rte). This template provides initial settings for the project such as its units, material used,
and display settings. You can customize the default settings of a project as required. The basic
template file has predefined information and settings for a project.

Generally, each organization has its own standard of working in a building project. Based on
the standard, a user can customize the template and then save it for further use.

Tip: [t is recommended to follow a slower approach to set wp a project and give more time
to create the standard template for practice and to organize the structure of the required
components in a project. This helps in carrying out the project smoothly and efficiently.

ESSENTIALS FOR AN MEP PROJECT

Before starting up an MEP Project, there are some essential tips that are recommended to be
followed for smooth functioning of a project. The essential tips are as follows:

Arrange a BIM Project Kick-off Meeting. It is recommended to arrange a BIM Project kick-off
meeting for the people involved in all disciplines and the BIM modeler. This meeting is essential
as it brings all the people involved in the project and provides everyone an opportunity to
share the information about the expectation of the clients and the firms from the building
model. Also, the information is shared on the expected Level of Development (AIA Document
E202) of the building model.

Establish a common Project Settings and Project Goal. It is required to establish project
settings and goals before starting up a new project in Revit MEP. Following are the project
settings and goals that you need to establish for the MEP project: File Structure, Shared
Coordinates, and the Project milestones.

Communicate with the Architects. Since the architects have been using Revit for a long time, it
is required to communicate with those who are involved in the project regarding the design.
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STARTING A NEW PROJECT

Application Menu: New > Project
Shortcut Key: CTRL+N

To start a new project in Revit MEP 2015, first you need to open the software. To open the
software, choose All Programs > Autodesk > Revit MEP 2015 > Revit MEP 2015 from the
Start menu; the Autodesk Revit MEP window will be displayed. From this window, choose the
Application button; the Application Menu will be displayed. From the Application Menu,
choose New > Project, as shown in Figure 2-1; the New Project dialog box will be displayed,
as shown in Figure 2-2.
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Figure 2-2 The New Project dialog box

In this dialog box, the Mechanical Template option is selected by default in the drop-down
list in the Template file area. As a result, the new project will adopt the settings of the
Mechanical-Default template file. Alternatively, you can select any of the following options
from the drop-down list in the Template file area: Electrical Template, Plumbing Template,
Systems Template, and <None>.
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Note
The selection of the option from the drop-down list depends on the MEP discipline that you are
going to work within the project.

Tip: For an MEP project it is recommended to start with the Systems.rte template file. To

O use this file, you need to select the Systems Template option from the drop-down list in the
Template file area of the New Project dialog box. This Systems.rte template file provides
a useful set up for all the disciplines such as Mechanical, Electrical, and Plumbing.

A template file has various project parameters saved in it such as units, views, and so on. When
you apply the template file to a new project, it will adopt the same parameters as that of the
template file. The difference between a template file format and a project file format is that
the former has a .7te extension, whereas the latter has a .rvt extension. You can either select
any of the template files provided in Revit MEP or create your own template file. You can also
save any project file as a template file.

You can select a file as template by choosing the Browse button in the Template file area of
the New Project dialog box. On doing so, the Choose Template dialog box will be displayed.
In this dialog box, you can browse to the specified file location and select the desired template
file of your choice and then choose the Open button; the Choose Template dialog box will
be closed and the selected file will be displayed as an option in the drop-down list that is
displayed in the Template file area of the New Project dialog box.

In the New Project dialog box, you can select the Project radio button to create a new project.
Alternatively, you can select the Project template radio button to start with a new project
template.

After specifying the various options in the New Project dialog box, choose the OK button; the
New Project dialog box will be closed and the Revit MEP Project interface will be displayed
with the applied settings.

PROJECT UNITS

Ribbon: Manage > Settings > Project Units
Shortcut Key: UN

Units are important parameters of a project as they provide a standard of

=l measurement for different entities. While installing Revit MEP , you are prompted to
set the Imperial (feet and inches) or Metric (meter) unit as the default unit system. Setting a
default unit system helps you start your project with a specific type of unit. To set units, choose
the Project Units tool from the Settings panel; the Project Units dialog box will be displayed,
as shown in Figure 2-3. Under the Units column in this dialog box, you can specify various
units that are relevant to the building project.
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Project Units =53]
Discipline: LCommen ']
Units Format ©o
Length | 1-511/32" L
Area 1235 SF
Volume 123457 CF
Angle 1235°
Slope [ 171/2" f12"
Currency [ 1234.57
Mass Density [ 1234.57 Ib/ft*

Decimal symbol/digit arouping:
[ 123,456, 789.00 ~|

Figure 2-3 The Project Units dialog box

In the Project Units dialog box, units are grouped into six disciplines: Common, Structural,
HVAC, Electrical, Piping, and Energy. Each discipline has a set of measurement parameters.
You can select any of these disciplines from the Discipline drop-down list in the Project Units
dialog box. The Format column in this dialog box displays the current unit format for the
corresponding parameter in the Units column. You can preview and select the possible digit
grouping and decimal separators from the Decimal symbol/digit grouping drop-down list,
which is at the lower left corner of the dialog box. Some of the disciplines that are used in
MEP projects are discussed next.

Note
@ The values for different parameters displayed in the Format column of the Project Units dialog
~ box may differ depending wpon the type of unit system, Imperial or Metric, selected for the project.
In this textbook, the Imperial unit system has been used in the tutorials and illustrations.

Common Unit Type

The Common unit type used in an MEP project includes the parameters such as length, volume,
angle, slope, and so on. In the Project Units dialog box, the Common option is selected by
default in the Discipline drop-down list, refer to Figure 2-3. The Common unit type used
in Revit MEP is similar to that used in other Revit platforms. Moreover, the settings of the
parameters of common units are similar to those used in other CAD programs. The methods
of setting various parameters under the Common unit type are discussed next.
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Setting Length Units

In an MEP project, you can assign a unit for the measurement of length. To do so, click on
the field corresponding to the Length parameter in the Format column of the Project Units
dialog box; the Format dialog box will be displayed. This dialog box displays the units of
length and their settings, as shown in Figure 2-4. Select the required unit from the Units
drop-down list in the dialog box: Decimal feet, Feet and fractional inches, Decimal inches,
Fractional inches, Meters, Centimeters, Millimeters, and Meters and centimeters. After
selecting the desired unit, you can specify the rounding value for the selected unit. To do so,
select the desired option from the Rounding drop-down list. For units other than Feet and
fractional inches and Fractional inches, you can specify custom rounding value using the
Rounding increment edit box placed next to the Rounding drop-down list. This edit box is
inactive by default. To make it active, first select any option from the Units drop-down list and
then the Custom option from the Rounding drop-down list. Once the Rounding increment
edit box is activated, you can specity the desired rounding value in it for the selected unit.

Format @

Use project settings

Units: |Feet and fractional inches v]

Rounding:

To the nearest 132" v]

Suppress trailing 0's
7] Suppress 0 feet

Show + for positive values
[ Use digit grouping

|:| Suppress spaces

[ oK ] [ Cancel ]

Figure 2-4 The Format dialog box

The Unit symbol drop-down list will be inactive if the Feet and fractional inches, Fractional
inches, or Meters and centimeters option is selected from the Units drop-down list.
Once you make the Unit symbol drop-down list active, you can select the desired option
from it to specify the measurement symbol to be used along with the unit of length in a
project. For example, to use the symbol ‘m’ after you select the Meters option from the
Units drop-down list, select m from the Unit symbol drop-down list as the measurement
symbol. You can select the Suppress spaces check box to remove all spaces around the
dash from the length strings. For example, you can remove spaces around the dash when a
length string is expressed in feet and fractional inches to denote a particular measurement.

Setting Area Units

In the Project Units dialog box, you can assign a unit to the measurements of areas. To do so,
click on the field corresponding to the Area parameter in the Format column of the Project Units
dialog box; the Format dialog box will be displayed. In this dialog box, you can set the unit for
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measuring the area by using the options in the Units drop-down list. This drop-down list contains
various options for the units of area such as Square feet, Square meters, Acres, and so on. By
default, the Square feet option is selected in this drop-down list, if the Imperial units system is
selected at the time of installing Revit MEP. The settings for rounding, rounding increment, and
unit symbol for the area units can be made from their respective drop-down lists and edit box.

dialog box, you should consider the extent of detailing required for the project. For projects
that requare too much detailing, a lower rounding value may be set. This parameter, however,
can be modified at any time during the project development.

g Tip: While selecting a rounding value from the Rounding drop-down list in the Format

Setting the Volume and Angle Units

Similar to setting the units for the length and area, you can set units for volume and angle. To
set unit for the volume measurement, click in the field of the Format column corresponding
to the Volume parameter in the Project Units dialog box; the Format dialog box will be
displayed. In this dialog box, click in the Units drop-down list and select any of the following
options: Cubic yards, Cubic feet, Cubic meters, and Liters. After selecting a suitable option
from the Units drop-down list, choose the OK button; the Format dialog box will be closed
and the selected unit for the volume measurement will be displayed in the field of the Format
column corresponding to the Volume parameter in the Project Units dialog box.

Similarly, you can specify the unit for the angle measurement by selecting the required option
from the Units drop-down list in the Format dialog box for the Angle parameter. You can
select either Decimal degrees or Degrees minutes seconds from the Units drop-down list to
specify the unit for the angular measurement.

Setting the Slope Units

To specify the unit for the slope measurement, click on the field corresponding to the Slope
parameter in the Project Units dialog box; the Format dialog box will be displayed. In this
dialog box, you can specify the desired unit by selecting it from the Units drop-down list. The
Units drop-down list contains options such as Ratio : 12, Ratio : 10, Rise / 12”, Rise / 1’-0”,
Rise / 1000mm, Decimal degrees, and Percentage. By default, Decimal degrees is selected
or unit for the slope measurement, if the Imperial unit system is set while installing Revit
MEP.

Setting the Currency Units

In Revit MEP, you can set the unit for currency as well. To do so, click on the field
corresponding to the Currency parameter in the Project Units dialog box; the Format dialog
box will be displayed. In this dialog box, select the required currency symbol and rounding
value from the Unit symbol and Rounding drop-down lists, respectively.

Setting the Mass Density Units

In Revit MEP, you can set the unit for mass density. To do so, click on the field corresponding
to the Mass Density parameter in the Project Units dialog box; the Format dialog box will
be displayed. In this dialog box, you can specify the desired unit by selecting it from the
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Units drop-down list. The Unit drop-down list contains options such as Kilogram per cubic
meter and Pound per cubic foot for mass density measurement. By default, the Pound per
cubic meter option is selected in this drop-down list, if you had selected the Imperial unit
system at the time of Revit MEP installation. The settings for the parameters of the rounding,
rounding increment, and units symbol can be set by selecting the required option from the
respective drop-down lists.

Note

You can format only the display of units on the screen or in the printout using the Project Units
dialog box. The actual values for these units in the project may be different. For example, if you
set the wall length rounding to the nearest value 1°, the wall may show this rounded value, but
the actual length of the wall might be in fractional feet.

HVAC Unit Type

HVAC units are commonly used while working in the Mechanical discipline of an MEP Project.
Some of the frequently used HVAC units are Density, Power, Pressure, Velocity, Air Flow, and
more. In Revit MEP, you can set the HVAC units in the Project Units dialog box. To do so,
select the HVAG option from the Discipline drop-down list in the Project Units dialog box,
as shown in Figure 2-5. Some of the important HVAC units are discussed next.

Project Units (2]
Discipline: [HiAC ]
Units Format o
Density 12345679 Ib/ Tt L
Friction 1234.57 in-wg/100ft
Power 1235 Btu/h
Power Density 1234.57 Wi
Pressure 1234.57 in-wg
Temperature 1235 °F
Velocity 1230 FPM
Air Flow 1235 CFM
Duct Size 17"
Cross Section 123457 in®
Heat Gain 12346 Btu/h
Roughness 1234.5679'
Viscosity 1234 57 cP
Air Flow Density 123457 CFM/SF 1
Lty N [P | EE ST ow
Decmal symbol/digit grouping:
[ 123,456,789.00 -
o ) om = )

Figure 2-5 The Project Units dialog box with the HVAC option
selected in the Discipline drop-down list

Setting the Unit for Power
To specify the unit for the power used for various HVAC units , click on the field corresponding
to the Power parameter in the Format column; the Format dialog box will be displayed. In
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this dialog box, specify a unit by selecting the required option from the Units drop-down
list. The Units drop-down list contains the options such as Watts, Kilowatts, BTU (British
Thermal Units) per second, BTU (British Thermal Units) per hour, and so on. For the
Imperial unit setting, BTU (British Thermal Units) per hour is the default option selected
in the drop-down list. For the Metric unit setting, Watts is the default option selected in the
drop-down list.

Setting the Unit for Pressure

The pressure in an HVAC system implies the static pressure of the system and of the air
flowing inside the duct. To specify unit for the pressure, click on the field corresponding to
the Pressure parameter in the Format column of the Project Units dialog box; the Format
dialog box will be displayed. In this dialog box, specify the desired unit by selecting an option
from the Units drop-down list. The Units drop-down list contains options such as Inches of
water(60 °F), Pascals, Kilopascals, Megapascals, Bars, and so on. The default unit selected
for the Imperial unit setting in the drop-down list is Inches of water(60 °F). The default unit
selected for the Metric unit setting in the drop-down list is Pascals.

Setting the Unit for Air Flow

The Air Flow parameter specifies the flow rate of the air flowing in the ducts in an HVAC
system. In Autodesk Revit MEP, to set the unit for the Air Flow parameter, choose the button
corresponding to this parameter in the Project Units dialog box; the Format dialog box will
be displayed. In this dialog box, you can select various options such as Cubic feet per minute,
Liters per second, Cubic meters per second, and so on. The default unit selected in the
imperial unit system for this parameter is Cubic feet per minute. The default unit selected
for the Metric unit setting in the drop-down list is Liters per second.

Setting the Unit for Heating Load

The Heating Load parameter specifies the heating load of the space for which the HVAC
system has to be designed. To set the unit for the Heating Load parameter, choose the
button corresponding to this parameter in the Project Units dialog box; the Format dialog
box will be displayed. In this dialog box, you can select any option such as Watts, Kilowatts,
BTU (British Thermal Units) per second, BTU (British Thermal Units) per hour, and so
on. The default unit selected in the imperial unit system for this parameter is BTU (British
Thermal Units) per hour. For the Metric unit setting, Watts is the default option selected in
the drop-down list.

Electrical Unit Type

Electrical units are commonly used while working in the Electrical discipline of an MEP Project.
Some of the frequently used Electrical units are Current, Electrical Potential, Frequency,
Iluminance, and more. To specify these units, invoke the Project Units dialog box and then
select the Electrical option from the Discipline drop-down list. Some of the frequently used
Electrical units are discussed next.

Setting the Unit for llluminance
The Iluminance in an Electrical system refers to the measurement of the illumination of
the surface. To specify unit for the illuminance, click on the field corresponding to the
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INluminance parameter in the Format column of the Project Units dialog box; the Format
dialog box will be displayed. In this dialog box, specify the desired unit for the illuminance
by selecting an option from the Units drop-down list. The Units drop-down list contains two
options Footcandles and Lux. The default unit selected for the Imperial unit setting in the
drop-down list is Footcandles. For the Metric unit setting, Lux is the default option selected
in the drop-down list.

Setting the Unit for Electrical Potential

In the Electrical discipline the Electrical Potential refers to the potential difference of two points
in the distribution. Generally, it is the voltage of the electrical supply to the equipment. In
Autodesk Revit MEP, to set the unit for the Electrical Potential parameter, choose the button
corresponding to this parameter in the Project Units dialog box; the Format dialog box will
be displayed. In this dialog box, you can select the required option from the various options
provided such as Volts, Kilovolts, and Millivolts. The default unit selected in the Imperial
and Metric unit systems is Volts.

Setting the Unit for Demand Factor

The Demand factor for an electrical system is the ratio of the maximum electrical load required
in given time period to the maximum possible electrical load available. In Autodesk Revit
MEP, to set the unit for the Demand Factor parameter, choose the button corresponding to
this parameter in the Project Units dialog box; the Format dialog box will be displayed. From
this dialog box, you can select any of the two available options: Percentage and Fixed. The
default unit selected for the Imperial and Metric unit systems is Percentage.

Piping Unit Type

Piping units include units for Density, Flow rate, Pressure, Velocity, and so on. In Revit MEP,
you can set the piping units in the Project Units dialog box. select the Piping option from
the Discipline drop-down list in the Project Units dialog box. Some of the piping units are
discussed next.

Setting the Unit for Flow

The flow in the piping system implies the flow rate of the water or fluids. To specify unit for
flow, click on the field corresponding to the Flow parameter in the Format column of the
Project Units dialog box; the Format dialog box will be displayed. In this dialog box, specify
the desired unit for the flow by selecting an option from the Units drop-down list. The Units
drop-down list contains options such as US gallons per minute, US gallons per hour, Cubic
meters per hour, and so on. The default unit selected for the Imperial unit setting in the
drop-down list is US gallons per minute. For the Metric unit setting, Liters per second is
the default option selected in the drop-down list.

Setting the Unit for Velocity

The velocity in the piping system implies the velocity of water or fluids. To specify unit for
velocity, click on the field corresponding to the Velocity parameter in the Format column of the
Project Units dialog box; the Format dialog box will be displayed. In this dialog box, specify
the desired unit for the flow by selecting an option from the Units drop-down list. The Units
drop-down list contains options such as Feet per second and Meters per second. The default
unit selected for the Imperial unit setting in the drop-down list is Feet per second. For the

Metric unit setting, Meters per second is the default option selected in the drop-down list.
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Setting the Unit for Pipe Size

The pipe size in the piping system implies the size of the pipes used in the piping distribution
system. To specify unit for pipe size, click on the field corresponding to the Pipe Size parameter
in the Format column of the Project Units dialog box; the Format dialog box will be displayed.
In this dialog box, specify the desired unit for the pipe size by selecting an option from the
Units drop-down list. The Units drop-down list contains options such as Fractional inches,
Decimal inches, Decimal feet, and more. The default unit selected for the Imperial unit
setting in the drop-down list is Fractional inches. For the Metric unit setting, Millimeters is
the default option selected in the drop-down list.

PROJECT TEMPLATES

Project templates are files commonly known as template files, which contain predefined
settings for projects, for the display of annotations, graphics, and so on. In a project,
these files contain predefined settings for units, mechanical components, electrical
components, and piping components. Similarly, for the display of graphics, the template files
contain predefined settings for materials, line styles, line weights, line patterns, and various
symbols relevant to the MEP project.

Project templates provide initial conditions for a project. In Revit MEP, when you install
the software you will find in-built templates that are saved with .rte as file extension. You
can also create your own template based on the project requirement. In Revit MEP, any
new template-based project inherits all families, settings (such as units, fill patterns, line styles,
line weights, and view scales), and geometry from the template.

The use of template file is quite extensive and it helps in reducing the cycle time of a project.
In the following sections, you will learn to create custom templates and then to use them in
a structural project.

Creating a Custom Project Template

In Revit MEP, there are various methods to create a custom project template. The common
method is to open an existing template file and modify its settings based on the project
requirement and then save it as a different template file. You can also create a custom project
template by starting a blank project file, defining all settings such as naming the viewports,
creating levels, adding grids, and others, and then saving it as a template (.rte) file. For certain
projects, you can create a template file which includes geometry that can be used repeatedly as
a base for the new projects. For example, if you have defined geometry for a hospital project
and want to include this geometry whenever you start a new project, you can save the file that
includes this geometry as a template. Each time you open a project with this template, the
geometry will be included.

Creating a New Template from a Blank Project File

In Revit MEP, you can create a new template file from a blank project file or use any of the
default template files (Mechanical-Default.rte, Electrical-Default. rte, Plumbing-Default. rte, and
Systems-Default. rte). To create a template file from a blank project file, choose New > Project
from the Application Menu; the New Project dialog box will be displayed. In the Template
file area of this dialog box, select the None option from the drop-down list. Next, select
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the Project template radio button in the Create New area and choose the OK button; the
Undefined System of Measurement message box will be displayed, asking you to select which
system of measurement do you want to use in your project, as shown in Figure 2-6. You can
select the Imperial or Metric option from this message box. If you choose the Imperial option,
a template file containing all default unit settings for the Imperial unit system will open.
Similarly, if you select the Metric option, the template file containing default units for the
Metric system will open. After opening the template file, you can modify its existing settings
based on your project environment and then save the modified file as a template file. To do
so, choose Save As > Template from the Application Menu; the Save As dialog box will be
displayed. In this dialog box, select a folder from the Save in drop-down list and enter a name
for the template file in the File name edit box. Note that the Template Files (*.rte) option is
selected from the File of type drop-down list. After entering the file name, choose the Save
button; the template file will be saved with the settings defined in the blank project file.

Undefined System of Measurement

Which system of measurement do you want to
use in your project?

= Imperial

< Metric

Figure 2-6 The Undefined System of Measurement message box

Note

@ You can also select the default template file, Systems-Default. rte, to create a new template file
for a blank project. To do so, select the Systems Template option from the Template file area
of the New Project dialog box, and then choose the OK button.

Creating a New Project Template from an Existing Project Template
To speed up your project, you may be required to use predefined template files. These template
files contain predefined information or settings pertaining to the project you need to start. To
use these template files, choose New > Project from the Application Menu; the New Project
dialog box will be displayed. In this dialog box, ensure that the Project template radio button
in the Create new area is selected. Now, to select the desired template file for your project,
choose the Browse button; the Choose Template dialog box will be displayed. In this dialog
box, browse to the desired folder to locate the template file. Next, select the template file from
the folder and choose the Open button; the Choose Template dialog box will close and the
New Project dialog box will be displayed again. In this dialog box, keep the default setting
and choose the OK button; a new project file will open, which inherits all project settings
from the selected template file.

Settings for the Project Template

While creating a project template, you can predefine certain settings based on your project
requirement. To start a new project template, you need to fill in the information specific to the
project. The information includes the name of the project, project number, client’s name, and
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so on. This information is useful while publishing or plotting the drawing. Next, you need to
enter the project settings. These settings include units, snaps, the line styles for components
and lines, fill patterns for materials, and more.

After modifying the project settings, you can create settings for families. The families in a
project template can be system families and loaded families. While defining the settings for the
project template, you can modify or duplicate system families (for example, walls) as required
for the project. You can also load the commonly used families, user-defined families, and
title blocks. After setting families in the project template, you can modify or create settings
for project views. The other settings that can be made for the project template are visibility/
graphics settings, and the plot (Print) settings. The settings for the project information are
discussed in the next section.

Setting the Project Information

When you create a project template, you can also set the project information. To do so,
choose the Project Information tool from the Settings panel of the Manage tab; the Project
Properties dialog box will be displayed, as shown in Figure 2-7.

X Project Properties @
Eamily: [System Family: Project Information v] Load...
Type: [ v] Edit Type...

Instance Parameters - Control selected or to-be-created instance

Parameter Value
Identity Data

Organization Name

»

Organization Description

Building Name

Author

Energy Analysis H
Energy Settings { Edit... }
Other 2
Project Issue Date Issue Date

Project Status Project Status

Client Name Owner

Project Address [ Edit...

Project Mame Project Mame

Project Number Project Number

[ o< J[ concet |

Figure 2-7 The Project Properties dialog box
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In this dialog box, you can specify various settings related to the project information displayed
in the Instance Parameters area. To enter information regarding the Organization Name,
Organization Description, Building Name, and Author of the project, click on the value
fields of their corresponding parameters and enter appropriate values in them. Similarly, to
edit the energy setting of the project, choose the Edit button in the Value field of the Energy
Settings parameter; the Energy Settings dialog box will be displayed. In this dialog box, you
can specify various settings related to the type of the building, site location of the building,
and the level that will represent the ground plane of the site. To do so, click on the Value
fields corresponding to the Building Type, Location, and Ground Plane parameters and
specify the desired values in them. In the Energy Settings dialog box, you can specify various
parameters under the Detailed Model heading to set the level of detail of the MEP model
for the propose of exporting it to a third party software or use it for energy analysis. In the
Energy Settings dialog box, you can also set various parameters under the Energy Model
and Energy Model - Building Services headings to specify various parameters for the energy
model of the MEP project. Next, choose the OK button; the Energy Settings dialog box will
be closed and the Project Properties dialog box will be displayed. In this dialog box, you
can enter information regarding the start date or the issue date of the project. To do so, click
on the Value field of the Project Issue Date parameter and enter a valid date. Similarly, to
specify the status of the project, click on the Value field of the Project Status parameter and
specify a valid status of the project.

To specity the location of the project, choose the Edit button in the Value field of the Project
Address; the Edit Text dialog box will be displayed. In the text area of this dialog box, specify
the location and choose the OK button; the location of the project will be updated. Next,
specify the name and number of the project in the Value fields of the Project Name and
Project Number parameters, respectively. After specifying the appropriate information in
the Project Properties dialog box, choose the OK button; the Project Properties dialog box
will close and the specified project information will be updated. In addition to the parameters
discussed in the Project Properties dialog box, you can add more parameters for entering
project information. These parameters can be a local parameter or a shared parameter. To add
a local parameter, choose the Project Parameters tool from the Settings panel of the Manage
tab; the Project Parameters dialog box will be displayed. Choose the Add button from this
dialog box; the Parameter Properties dialog box will be displayed, as shown Figure 2-8.

In the dialog box, ensure that the Project parameter radio button is selected in the Parameter
Type area of this dialog box. Next, in the Categories area, ensure that the Architecture option
is selected in the Filter list drop-down list. Also in the list box of this area, select the Project
Information check box. In the Parameter Data area, enter the name of the parameter data
in the Name edit box. For example, you can specify MEP Consultant meter. Next, you need
to assign a discipline for the new parameter. To do so, select an appropriate option from
the Discipline drop-down list. For example, to assign a discipline for the MEP Consultant
parameter, ensure that the Common option is selected in the Discipline drop-down list. To
assign type and group for the MEP Consultant parameter, select the Text and Other options
from the Type of Parameter and Group parameter under drop-down lists. Next, choose the
OK button twice; the Parameter Properties and the Project Parameter dialog boxes will be
closed and the MEP Consultant parameter will be added in the Project Properties dialog
box. Figure 2-9 shows the Project Properties dialog box for the project information with MEP
Consultant as the added parameter.
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Figure 2-8 The Parameter Properties dialog box
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Figure 2-9 The added parameter in the Project Properties dialog box

Setting the Project Location

For every project in MEP, you need to define its geographical location (azimuth), which includes
the latitude and longitude of the nearest city and the coordinate system of the host model and
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the linked model (if present). To do so, choose the Location tool from the Project Location
panel of the Manage tab; the Location Weather and Site dialog box will be displayed, as
shown in Figure 2-10.

Location Weather and Site @

Location | weather | Site

Define Location by:

’Internet Mapping Service v]

Project Address:

T
ool vinched  nap | satelite | Hybrid | Terrain |
.

\

| Project Address:  Boston, MA
Relmont

5 hatitude: 42.213
B! -.-.' | 1g-RRgTuas: | Map ﬂgﬁ'@%ﬁ&ﬁgagggﬂrme of UEE
[C] Use Daylight Savings time

[ 0K ][ Cancel H Help ]

Figure 2-10 The Location Weather and Site dialog box

This dialog box contains three tabs: Location, Weather, and Site. The Location tab is chosen
by default. In the Define Location by drop-down list of this tab, the Internet Mapping
Service option is selected by default. As a result, you can use the Google map service to find
out the geographical location of the desired place. To find out the geographical location, type
its name in the Project Address edit box and then choose the Search button; the location
searched will be displayed in a map. Alternatively, you can select the Default City List option
from the Define Location by drop-down list to specify the city and to define the latitude and
longitude of the location. To specify the city, select an option from the City drop-down list;
the Latitude and Longitude edit boxes will display the corresponding values for the latitude
and longitude of the selected city. If the name of a city is not available in the City drop-down
list, then enter the values of its latitude and longitude in the Latitude and Longitude edit
boxes, respectively. You can choose the Weather tab in the Location Weather and Site dialog
box to specity the cooling and heating design temperature of the site through-out the year.
In this tab, the Use closest weather station check box will be selected by default. As a result,
the value of the cooling design temperature of the proposed project will be taken from the
data of the weather station to the location specified in the Location tab. You can clear the Use
closest weather station check box and specify the value of the cooling and heating design
temperature for all months in the table displayed under the Cooling Design Temperatures
head. In the Weather tab, you can specify the value for the Heating Design Temperature and
the Clearness Number in their respective edit boxes.

In the Weather Location and Site dialog box, you can choose the Site tab in the Location
Weather and Site dialog box to name the current setting of the location. The options in the
Site tab are shown in Figure 2-11. In this tab, the name(s) of location(s) is (are) displayed in
the Sites defined in this project list box. By default, the Internal (current) location is listed
and selected in the list box. To define a different location for the project, choose the Duplicate
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button; the Name dialog box will be displayed. Enter a name in the Name edit box and choose
the OK button; the Name dialog box will be closed and the name of the new location will be
listed in the Sites defined in this project list box. After you have added a location, you will
notice that the Delete and Make Current buttons are active. You can choose the Delete button
to delete location(s) apart from the current location. Current location is the location currently
being used. To make a location current, select the location from the Sites defined in this
project list box and choose the Make Current button. Note that after you have made a location
current, the name of the location is suffixed with the word (current).

Location Weather and Site @

Lacation I Weather | Site

Used for orientation and position of the project on the site and in relation to
other buildings. There may be many Shared Sites defined in one project.

Sites defined in this project :

Delete

Make Current

Angle from Project North to True Morth :
0°00' 00" East

o) (o ) e

Figure 2-11 The options in the Site tab of the Location
Weather and Site dialog box

Transferring Project Standards

When you create a template file, you can copy project standards from some other project to
the current file. These standards include various project settings such as Family Types (only
system families, not loaded families), line weight, line styles, line patterns, materials, view
templates, and so on. To transfer project standards to the template file (target file), open
the source file from which the standards are to be copied. Next, choose the Transfer Project
Standards tool from the Settings panel of the Manage tab; the Select Items To Copy dialog
box will be displayed, as shown in Figure 2-12.

Note

@ If you invoke the Transfer Project Standards tool without any opened files in the current
session, the Revit message box informing that theve are no open projects to transfer project from,
will be displayed. Choose the Close button in this message box and then open a project in the
current session from which you want to transfer the project standard to the current project.

In the Select Items To Copy dialog box, click on the down arrow in the Copy from drop-down
list; a list of opened projects will be displayed in the drop-down list. Next, select the project
from which you want to copy the project standards. Note that when you select a source project
from this list, the standards included in the project are displayed along with their respective
check boxes. By default, all check boxes in the list box are selected. You can keep the check
boxes selected corresponding to the standards to be copied to the template file and clear the
rest of them. If you want to clear all check boxes for fresh selection, you can choose the Check
None button located on the right of the list box. Similarly, to select all check boxes, you can
choose the Check All button. After selecting the check boxes for the standards that you want
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to transfer, choose the OK button; the Select Items To Copy dialog box will be closed. Note
that if the selected standards are already present in the template file, the Duplicate Types
message box will appear, as shown in Figure 2-13. You can choose the Overwrite button from
this message box to overwrite the common standards or choose the New Only button to
transfer the standards that are present in the template file. After you have chosen the required
options, the selected standards will be copied to the destination file.
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Figure 2-12 The Select Items To Copy dialog box
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Figure 2-13 The Duplicate Types message box

Setting the Browser Organization

While creating a project template, you can organize the Project Browser. To do so,
choose the Browser Organization tool from the Windows panel of the View tab; the Browser
Organization dialog box will be displayed, as shown in Figure 2-14. This dialog box contains
two tabs: Views and Sheets. The Views tab is chosen by default. The options in this tab are
used to select, edit, or create a browser organization for the views present in the project.
In the list box of the Views tab, list of default browser organizations is displayed with their
respective check boxes.
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Figure 2-14 The Browser Organization dialog box

By default, the check box for all browser organization is selected. You can edit the settings
of the check boxes displayed. To do so, click on the name of the browser organization whose
settings you want to change, and then choose the Edit button; the Browser Organization
Properties dialog box will be displayed, as shown in Figure 2-15. This dialog box contains
two tabs: Filtering and Grouping and Sorting. The Filtering tab is chosen by default. You
can use various options in this tab to apply a filter to project views. In the Filter by area of
this tab, you can specify view property, filter operator, and filter value required for sorting
and grouping the project views. After specifying various options in the Filtering tab, you can
choose the Grouping and Sorting tab to create group by sorting the project viewing, refer
to Figure 2-15. . Next, choose the OK button from this dialog box; the Browser Organization
Properties dialog box will close and the settings for the selected browser organization will
be edited. Similarly, you can create a new browser organization for the project views. To do
so, ensure that the Views tab is chosen from the Browser Organization dialog box and then
choose the New button from it; the Browser Organization Name dialog box will be displayed.
In this dialog box, you can enter the name of the new browser organization in the Name edit
box and then choose the OK button; the Browser Organization Properties dialog box will
be displayed. The options in this dialog box have already been discussed. Similar to creating
browser organization for a project view, you can also create browser organization for sheets.
To do so, choose the Sheets tab from the Browser Organization dialog box. The Sheets tab
displays a list box containing the list of default browser organizations for sheets. The options
in this tab are similar to those discussed for the Views tab.

LINKING REVIT MODELS AND SHARING COORDINATES

You can link a Revit Architecture and Revit Structure project file (.rvt) with a Revit MEP
project. After linking, you can use the project created in Revit MEP to coordinate and monitor
the changes in the architectural and structural model, respectively. In addition, you can use
various tools in Revit MEP to check for correct interference condition between the elements
in the Architectural and Structural models and the elements in the MEP model. Linking Revit
models is very similar to Xrefs (External Reference) in AutoCAD.
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Figure 2-15 The options in the Grouping and Sorting tab

When you link a model, you need to share the coordinates of the host model with the linked
model so that the linked files retain their positions. To do so, invoke the Acquire Coordinates
tool from Manage > Project Locations > Coordinates drop-down and then select the linked
project in your drawing. On selecting the linked project, the origin of the linked project’s shared
coordinate becomes the origin of the host project’s shared coordinates. Revit MEP provides the
flexibility and easy management of the linked models by enhancing the linking of the models
and organizing the linked files in the Project Browser. You can easily access the linked files,
the nested link files, and the link manager from the Project Browser. The nested Revit links
are also listed under the Revit Links head with the host link in the Project Browser.

To link or import the Revit files, choose the Link Revit tool from the Link panel of the
Insert tab; the Import/Link RVT dialog box will be displayed, as shown in Figure 2-16. In this
dialog box, navigate to the desired folder and select the file to be linked with the host project;
the preview of the selected project file will be displayed in the Preview pane. Choose the Open
button to open the file. Select the appropriate positioning option from the Positioning area
to position the model automatically or manually in the host project.
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Figure 2-16 The Import/Link RVT dialog box

Linked Revit Models in the Project Browser

The linked Revit models are listed in the Project Browser under the Revit Links head. You
can access the linked model files and also link a new file from the Project Browser. To do so,
select the Revit Links sub-node in the Project Browser and right-click; a shortcut menu will
be displayed. Choose New Link from the shortcut menu; the Import/Link RVT dialog box
will be displayed. Select the file to be linked from this dialog box. Similarly, you can access
the link manager by choosing Manage Links from the shortcut menu and manage the links.
You can also open the linked model in the project by dragging it from the Project Browser
and dropping it in the project view.

Converting Linked Models to Groups - Binding Links

You can convert the linked Revit models into groups in the host project. You can do so by
binding the linked model with the host project, thereby making it a part of the host project.
After binding the linked model, the model geometry will be transformed into a group, and
therefore making changes in the host project will be easier for you. To bind and group a linked
model, select the linked model in the drawing; the Modify | RVT Links tab will be displayed.
Choose the Bind Link tool from the Link panel; the Bind Link Options dialog box will be
displayed, as shown in Figure 2-17. In the dialog box, select the Attached Details, Levels, and
Grids check boxes to include them in the group and then choose the OK button; the linked
model will be converted into a group. If there is any group in the project with the same name
as that of the linked Revit model, a dialog box with a message will be displayed asking whether
or not you want to replace the group. Choose Yes to replace the existing group or choose
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No to rename the group. On choosing Yes, the Autodesk Revit 2015 warning message box
will be displayed. This message box will inform to remove the link from the current project.
Choose the Remove Link button in the message box or choose the OK button to remove it
later; the linked model will transform into a group and will be listed in the Project Browser
under the Groups head.

Bind Link Options (23]
Indude

Attached Details
[ Levels
[~ Grids

MNote: Checking Levels and Grids will create additional
uniquely-named levels and grids in addition to those
presently in the praject.

E OK i [ Cancel ]

Figure 2-17 The Bind Link Options
dialog box

Controlling the Visibility of Linked Models

You can control the visibility of the linked and nested Revit linked models in the host project
file. Also, you can control the visibility settings, detail level, and display settings of the building
elements in the linked project. To modify the visibility settings in the host project, open the
view in which the visibility settings are to be modified. Choose the Visibility/Graphics tool from
the Graphics panel in the View tab to display the Visibility/Graphic Overrides dialog box.
The Revit Links tab in this dialog box displays the linked projects, as shown in Figure 2-18.
Note that this tab will be displayed only when the files are linked in your project. Click on the
project name to display the categories of components in the building model. Use the Halftone
and Display Settings columns to modify the visibility settings and the filters of the components
of each linked project. The By Host View button in the Display Settings column can be used
to control the visibility of the nested links, phases, and phase filters.

Click in the Display Settings column; the RVT Link Display Settings dialog box will be
displayed. Choose the Basics tab from the dialog box. If you select the By host view radio
button in this tab, the nested linked model will be able to use the same visibility and graphics
settings as in the host view. On selecting the By linked view radio button, the nested linked
model adopt the visibility settings of the parent model to which it was linked originally. Also,
the Linked view drop-down list will be enabled. You can select the view in which you want to
display the linked model from this list. On selecting the Custom radio button, all the options
in the Basics tab will be enabled. From the Nested links drop-down list, select the By parent
link option to apply the visibility settings of the parent model to the nested link model. If you
select By linked view from the drop-down list, the visibility and graphics override settings
of the top level nested model will be applied to the linked model. The top level model is the
first nested linked model. In the example explained earlier, project A will be the top-level
nested model. Choose the Apply button to view the changes in the project and then choose
the OK button.
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Figure 2-18 The Visibility/Graphic Overrides dialog box with the Revit Links
lab chosen

Managing Links

In an MEP project, you can manage links between the host and the linked projects. To do
so, choose the Manage Links tool from the Link panel of the Insert tab; the Manage Links
dialog box will be displayed with a list of linked projects, as shown in Figure 2-19.

The Status column in the Manage Links dialog box informs whether the linked project file is
loaded in the host project. The Reference Type column in the dialog box provides you with
the options to display or hide the nested linked Revit models. The default Overlay value in
the Reference Type column restricts the loading and display of the nested linked models
in the host project. The Position Not Saved column of the dialog box indicates whether or
not the linked models location is saved in its shared coordinate system or not. The shared
coordinates take care of the mutual positions of multiple interlinked files. The Saved Path
column shows the path of the linked file on your computer. The Path Type column is used to
specify whether the saved path of the linked file is relative or absolute. It is recommended to
keep the linked path relative because it enables Autodesk Revit MEP to trace and re-establish
the link, if the host and linked projects are moved to a different folder.

Including Elements of Linked Models in Schedules
In Revit MEP, you can include different model elements such as walls, doors,and windows
from a linked file into a schedule. To do so, select the existing schedule of the current
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project from the Schedules/Quantities head in the Project Browser; the instance
properties of the selected schedule will be displayed in the Properties Palette. In the value
column of the Palette, choose Edit from the Fields parameter; the Schedule Properties dialog
box will be displayed. Select the Include elements in Linked files check box to include the
elements of a linked file, if required. To include project information from a linked file, select
Project Information from the Select available fields from drop-down list. Choose the Apply
button to view the changes in the project and then choose the OK button.

Manage Links @
Revit | CAD Formats I DWF Markups | Point Clouds
T Reference | Positions .
Linked File Status Tz Not Saved Saved Path Path Type Local Alias
RIL Project File.nvt Loaded Overlay E\Revit Projects\Projects\ | Relative
Save Positions Reload Erom... Reload Unload Remove
Manage Worksets
[ ok J[ cancel || aemiy Help

Figure 2-19 The Manage Links dialog box

Copying Linked Model Elements

You can copy the elements of the linked model to the host model. To do so, move the cursor
over the linked model and press TAB to highlight the required elements, in case the file has
a nested link. Click on the element when it is highlighted and choose the Copy tool from
the Clipboard panel of the Modify | RVT Links tab. Next, open the host file in which you
want to paste the element and choose the Paste from Clipboard tool from the Clipboard
panel; the linked model file from which you have selected the element will be displayed in the
Project Browser under the Revit Links head. You can place the element either by clicking at
the required location in the drawing area or by dragging the linked model from the Project
Browser and dropping it in the drawing area.
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Copying and Monitoring Linked Model Elements

After linking a Revit Architecture project, you need to constantly monitor the changes made to
the elements in the Revit MEP Project. This ensures that there are no conflicts or interference
conditions between architectural and MEP elements. You can coordinate and monitor the
changes made to Architectural and MEP elements by establishing relationships between
them. To do so, choose the Select Link tool from the Collaborate > Coordinate > Copy/
Monitor drop-down; you are prompted to select the linked model. Select the linked model
from the drawing area; the Copy/Monitor contextual tab will be displayed. In this tab, you can
choose the Copy tool from the Tools panel to copy the desired element in the linked model
to the host project. Also, from the Tools panel you can choose the Monitor tool to establish a
relationship between pair of corresponding elements in the linked model and the host model.
An eye symbol is displayed next to the element when an element is monitored, indicating that
a relationship is being established. After using various tools in the Copy/Monitor contextual
tab, choose the Finish button from the Copy/Monitor panel to finish the process.

SNAPS TOOL

Ribbon: Manage > Settings > Snaps

The Snaps tool is one of the important tools used to snap elements in an MEP model. This
tool is used to make the cursor snap or jump depending on the preset increments or on the
specific object properties of elements such as endpoint, and midpoint of elements. When you
invoke the Snaps tool from the Settings panel of the Manage tab, the Snaps dialog box is
displayed, as shown in Figure 2-20. This dialog box has three areas, Dimension Snaps, Object
Snaps, and Temporary Overrides. These areas are discussed next.

Note
The settings specified in this dialog box will be applied to all the projects opened in the session
and will not be saved.

Dimension Snaps Area

In the Dimension Snaps area, you can set the length and angle dimension snap increments
for placing the elements and components in a project. The dimension snap determines the
increment, linear or angular, by which the cursor will jump/snap linearly or angularly while
placing elements and components in a project.

The Length dimension snap increment check box is selected by default. As a result, you
can set the snap increment value for the length in the edit box below it. The default values
in this edit box are: 4’; 0°6”; 0’17; 0°0 1/4”(1000 ; 100 ; 20 ; 5 ). Note that every incremental
value is separated by a semicolon (;). You can change these values as per your requirement.
For example, to create an interior layout plan in which the length of partitions is in 5’ (1500
mm) modules, counter top width is 2°(600 mm), and thickness of partitions is 4”(100), you can
enter the values for the dimension snaps as 5’; 2°;4”. In Metric, you can enter a value of 1500;
600;100. This will enable the cursor to move in these increments and help create the layout
with relative ease. Similarly, you can set the top-down angular dimension snap increments.
However, ensure that the Angular dimension snap increments check box is selected and then
enter suitable value(s) in the edit box below it. This parameter is quite useful for the projects
that have radial geometry.
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Figure 2-20 The Snaps dialog box

Note

The reason for specifying multiple length and angle snap increment values in the edit boxes is
that the priority of increments may change on changing the zoom level of the drawing. Therefore,
when you zoom in the drawing, Revit MEP will use smaller increment values whereas on zooming
out, the larger increment values will be used.

®

Object Snaps Area

Object Snaps refer to the cursor’s ability to snap to geometric points on an element such as its
endpoint, midpoint, perpendicular, and so on. In the Object Snaps area of the Snaps dialog box,
you can specify options to snap points of elements or objects in a project. The advantage of
using these options is that you do not need to specify the exact point in a drawing. When the
object snap function is enabled, the suitable object snap is displayed as the cursor is moved
close to an element. For example, it is virtually impossible to pick the exact endpoint to start
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a wall from the endpoint of an existing wall. But when you enable the endpoint object snap,
the cursor automatically jumps or snaps to the endpoint of the wall. This helps in identifying
and selecting endpoint of the wall and then selecting a new wall from the endpoint. This,
besides making the drawing accurate, later helps add dimensions to the project.

Note
The object snapping works only with the objects that arve visible on the screen. A tooltip with
a name as that of the object snap is also displayed when you bring the cursor close to a snap
point.

In an MEP model, you can use various object snaps modes such as Endpoints, Midpoints,
Nearest, Work Plane Grid, Quadrants, Intersections, Centers, Perpendicular, Tangents,
Points, Snap to Point Clouds, and Snap to Remote Objects.

The name of each object snap option suggests its usage in the project. For example, the Work
Plane Grid snap option helps you snap the intersection points of grid lines in a work plane
grid that is displayed for the current work plane.

Each object snap mode is represented by a distinct geometrical shape to identify it from other
object snaps. For example, the endpoint object snap is represented by a square cursor, midpoint
by a triangular error, nearest by a cross, and so on. To use an object snap mode, move the
cursor on the object. As you move it close to the snap point, a marker appears. To select the
appropriate snap point, click when the corresponding marker or tooltip is displayed.

In Revit MEP, all enabled object snaps work simultaneously. You can turn off all snap options,
including dimension snaps and object snaps by selecting the Snaps Off check box located at
the top of the Snaps dialog box. Alternatively, you can type SO on the keyboard to turn them
off and on, while using a tool. The Check All and Check None buttons are used to select or
clear all check boxes (except the Snap to Remote Objects) in the Object Snaps area.

The Temporary Overrides Area

The options in the Temporary Overrides area provide you with an alternative of overriding
snaps setting for a single use only. For example, if you have not selected the Endpoints check
box in the Snaps dialog box and you want to use this option while working with a tool, you
do not need to open the Snaps dialog box to select this option. Instead, you can type the
shortcut, SE in this case, to temporarily activate the endpoint object snap. Once you have used
this object snap option, snapping to the endpoint is automatically turned off.

Using overrides, you can toggle between various object snap options available at the same
location. To do so, press the TAB key while snapping the points in the drawing. You can also
use other overrides like pressing the SHIFT key to create elements vertically or horizontally.
This restricts the movement of the cursor in the orthogonal directions only. Once you release
the SHIFT key, the cursor resumes its previous state. You can select the Snaps Off check box
to disable all types of snapping.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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SAVING AN MEP PROJECT

Before you close or exit a Revit MEP session, it is recommended to save the project file. You can
save a project file in a permanent storage device, such as a hard disk or a removable storage
device like CD or USB. Also, you must save your work at regular intervals to avoid data loss
due to any error in the computer’s hardware or software.

Using the Save As Tool

In Revit MEP, you can save your project file at the desired location by using the Save As tool. To do
so, click the Application button and then choose Save As > Project from the Application Menu;
the Save As dialog box will be displayed.

In the Save As dialog box, the Save in drop-down list displays the current drive and path in
which the project file will be saved. The list box below the Save in drop-down list displays all
folders available in the current directory. The File name edit box is used to specify the name
to be assigned to the project or file. The Places List area on the left of the Save As dialog box
contains shortcuts for the folders that are frequently used.

You can use different file saving features by choosing the Options button from the Save As
dialog box. On choosing this button, the File Save Options dialog box will be displayed. In
the Maximum backups edit box of this dialog box, you can specify the maximum number of
backup files that you need to store for a project. In Autodesk Revit MEP, the non-workshared
projects have three backup files and the workshared projects have twenty backup files by default.
The options in the Worksharing area are inactive for non-workshared projects. You can use
the options in this area to make the current workshared file central compact and select the
default workset. The options in the Preview area enable you to specify the image to be used
as the preview of the project file. This image is used at the time of opening a project file. You
can specify a view of the model as a preview image by selecting the corresponding option from
the Source drop-down list in the Thumbnail Preview area of the File Save Options dialog
box. By default, the Active view/sheet option is selected in the Source drop-down list of the
Preview area for the preview of a project file. For example, to make Floor Plan 1-Mech as
the preview image, select it from the drop-down list. As a result, when you invoke the Open
dialog box and select a file to open, the view displayed in the Preview area will correspond
to the selection that is made in the Source drop-down list of the File Save Options dialog
box. In the File Save Options dialog box, you can select the Regenerate if view/sheet is not
up-to-date check box to see the preview with the latest modifications. On selecting this check
box, the preview image will be updated when you close the project file.

Note
Revit MEP updates the preview image continuously. Therefore, selecting the Regenerate if
view/sheet is not up-to-date check box can consume considerable resources.

Using the Save Tool

Once a project has been saved using the Save As tool, you do not need to re-enter file parameters
to save it again. To save a project to the hard disk, choose the Application button and then
choose the Save option from Application Menu. If you are saving the project for the first time,
the Save As dialog box will be displayed, even if you invoke the Save tool. Alternatively, you
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can save your project by choosing the Save button from the Quick Access Toolbar. As you
save your project file, Revit MEP updates it automatically without prompting you to re-enter
the file name and path.

THE OPTIONS DIALOG BOX

In Autodesk Revit MEP, you can configure global settings by using the Options dlalog
box. This dialog box can be invoked by choosing the Options button from the
Application Menu. The Options dialog box, as shown in Figure 2-21, contains nine tabs:
General, Graphics, File Locations, Rendering, Check Spelling, SteeringWheels, ViewCube,
User Interface, and Macros. and Fabrication. These tabs are discussed next.

Options @

User Interface Save reminder interval:

Graphics Synchronize with Central reminder interval: | 30 minutes ']

File Locations

. Username
Rendering

CADCIM

‘You are currently not signed in to Autodesk 360, When you sign in, your
Autodesk ID will be used as your username.

Check Spelling

SteeringWheels

ViewCube Sign In to Autodesk 350
Macros Journal File Cleanup

When number of journals exceeds: 10 =
then
Delete journals older than (days): 10 =

Worksharing Update Frequency

Less Frequent More Frequent

I

Every 5 seconds

View Options

Default view disdpline:

[ OK ][ Cancel H Help

Figure 2-21 The Options dialog box

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-30 Exploring Autodesk Revit MEP

General Tab

The General tab is chosen by default and contains five areas: Notifications, Username,
Journal File Cleanup, Worksharing Update Frequency, and View Options. These areas are
discussed next.

Notifications Area

Revit MEP provides an option for setting reminders to save the work at regular intervals.
To do so, select the desired option from the Save reminder interval drop-down list in the
Notifications area. By default, 30 minutes is selected in this drop-down list. If you do not
want a reminder to save your work in the project, select the No reminders option from this
drop-down list. Similarly, you can select a value from the Synchronize with Central reminder
interval drop-down list. On doing so, you set the duration for the display of the reminder for
synchronization of the local file with the central file.

Username Area

In Revit MEP, you can create a unique identification for a particular session. To do so, enter a
name for the session in the edit box displayed in this area. The name entered in this edit box will
be used for granting permissions for editing in a multiuser Revit MEP environment. Note that
if you sign in Autodesk 360, the edit box will display the Autodesk ID with which you will
sign in.

Note

@ When you run Autodesk Revit MEP in your system for the furst time, you will notice that the
Windows login name is displayed as the default username in the edit box in the Username
area.

Journal File Cleanup Area

Journal files are the text files that are used to resolve technical problems occurred during
the Revit MEP session. These files record every step during the session. Whenever you
encounter a technical problem with the software, you can run this file to detect the problem
or recover the lost files or to know the steps that may have caused the problem. In Autodesk
Revit MEP 2015, these files are saved at the following default location: C:\Users| < Username>\
AppData\Local\Autodesk\Revit\Autodesk Revit MEP 2015|Journals for Windows 7 or Window Vista
users and C:\Documents and Settings\<Username>\Local Settings\Application for Windows XP
users. These files are saved each time you close the Revit MEP session. Therefore, the number
of these files keeps on increasing until you remove these files from their location. However
to remove these files while retaining some of them, you can use the Journal File Cleanup
area in the General tab of the Options dialog box. This area contains two spinners: When
number of journal exceeds and Delete journals older than (days). You can set the required
values in these spinners to retain the recently created files. For example, if you want to delete
journal files if their number exceeds 15 and if they were created before 30 days, then in such a
situation, set the value in the When number of journals exceeds spinner to 15 and the value
in the Delete journals older than (days) spinner to 30.

Worksharing Update Frequency Area

In this area, you can set the update frequency that indicates the time interval for updating
the project in a worksharing environment. To specify the limits for worksharing, you can set
the slider between the Less Frequent and More Frequent limits.
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View Options Area

In the View Options area, you can specify the default view discipline to be used in the Revit
MEP project. To do so, select an option from the Default view discipline drop-down list in
this area. In this drop-down list, the Mechanical option is selected by default.

Graphics Tab

The options in the Graphics tab are used to configure the display card of your computer
to improve the display performance. You can also use this tab to assign colors to selections,
highlights and alerts, and enable anti-aliasing for 3D views. In the Graphics Mode area of this
tab, the Use Hardware Acceleration check box is selected by default. As a result, the hardware
accelerators are enabled. Hardware accelerators help in displaying the models of larger size
faster on refreshing the views. In addition, the hardware accelerators help you speed up the
process of switching between the views of windows. In Autodesk Revit MEP 2015, the Use
Optimized View Navigation check box in the Graphics Mode area is selected by default. As
a result, you will get the improved display while navigating a 2D view or a 3D view using the
following methods of navigation: using the ViewCube, using the tools in the Navigation Bar,
navigating by scrolling the mouse wheel, and while using the Keyboard shortcuts.

The following table shows the list of features barred for visual styles :

Feature Visual Styles
Hidden Line Shaded Consistent Realistic
Colors

Edges | - Barred Barred Barred
Fill Patterns Barred Barred Barred Barred
Shadows Barred Barred Barred Barred
Structural Barred Barred Barred Barred
Hidden Lines

Mechanical Barred Barred Barred Barred
Hidden Lines

Note
While navigating a camera view in the Wireframe view style, the fill patterns are not
displayed in the model.

In the Graphics Mode area, the Smooth lines with anti-aliasing check box is selected by
default. As a result, the options for controlling the smooth lines will be enabled. You can clear
the check box to disable the options for controlling the smooth lines with antialiasing .

In the Colors area of the Graphics tab, select the Invert background check box to toggle
the color of the background and elements. The Selection parameter is used to assign a color
that an element acquires when it is selected. The default color is RGB 000-059-189. To use
any other color, click the button on the right of the Selection parameter to display the Color
dialog box and then select the desired color. The Pre-selection parameter specifies the color
of the highlighted elements. To use any other color for highlighting the element, click the
button on the right of the Selection parameter and select the desired color from the Color
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dialog box displayed. Autodesk Revit MEP 2015 uses the Alert button to highlight elements
when an error occurs. In the Colors area, the Semi-transparent check box is selected by
default. As a result, you can make the selected elements semi-transparent and you can view
the elements that are behind the selected elements. In the Temporary Dimension Text
Appearance area, you can select an option from the Size drop-down list to specify the size of
the text to be used in temporary dimensions. In this area, you can set the background of the
text in the temporary dimensions. To do so, select the Opaque or Transparent option from
the Background drop-down list.

File Locations Tab

The options in the File Locations tab are used to set the path for various files and directories
that are accessed frequently, refer to Figure 2-22. The path for these files is set while installing
Revit MEP. However, you can modify the location of a file by choosing the corresponding Browse
button and specify a new location. You can also change the default location of a template file,
in case you wish to use a customized template file for your projects. In Revit MEP, the default
path to save or open a project can be specified in the Default path for user files edit box. You
can also specify the default path for family template files and for the point clouds by using
the corresponding Browse button.

Options E5R
General Project template files: The first five project templates will appear as links on the
Recent Files page.
User Interface
+E Mame Path
Graphics n Mechanical Templ... | C:\ProgramDatat\Autodesk\RME 2015\ Tem...
E Electrical Template :C\ProgramDatat\Autodesk\RME 20154 Tem...

dh Plumbing Template : C:\ProgramData\Autodesk\RME 2015\ Tem...
Systems Template  C:\ProgramData\Autodesk\RME 2015\ Tem...

Rendering

Check Spelling =

SteeringWheels

ViewCube
Default path for user files:

M
acros C:\Users\CADCIM'\Documents

Default path for family template files:
C:\ProgramData \Autodesk\RME 20 15\Family Templates\English

Root path for paint douds:

C:\Users\CADCIM'Documents\PointClouds

[ QK ]’ Cancel ][ Help ]

Figure 2-22 The Options dialog box displaying the options in the File Locations tab
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Rendering Tab

Autodesk Revit MEP uses the mental ray rendering engine for its rendering process. The mental
ray has its own library, Render Appearance Library. This library stores information about
render appearances for materials, default RPC contents in the software, and other information
relevant to the rendering process. The Render Appearance Library is a read-only library and is
loaded into the following default location while installing the Revit MEP software: C:|Program
Files (x86)\Common Files | Autodesk Shared | Materials | 201 5\assetlibrary_base.fbm. In addition to the
default Render Appearance Library location, you can also specify paths for the additional image
files defining texture, bump map, and custom color for the render appearance that you can
use in the project. These image files are not present in the software and therefore, you need
to specify their paths to use them. To do so, choose the Add Value button in the Additional
Render Appearance Paths area and specify the required path in the displayed field or choose
the Browse button; the Browse for Folder dialog box will be displayed. In this dialog box,
select the desired path and choose the Open button to add the path in the field.

Check Spelling Tab

Revit MEP provides you with the option to run spell check to find out spelling errors in text
and then rectify them. You can choose the Check Spelling tab from the Options dialog box to
display its options. Figure 2-23 shows various options in the Check Spelling tab. In the Settings
list box of this tab, you can specify various self-explanatory settings by selecting their respective
check boxes. You can select the type of dictionary to be used as main dictionary for the spell
check from the Autodesk Revit drop-down list in the Main Dictionary area. Apart from the
main dictionary, you can also use additional dictionaries available in MEP such as the personal
and building industry dictionaries. There are many words that are not included in the main
dictionary but are frequently used in the building industry. For example, the abbreviation ‘conc’
for the word concrete is not available in the main dictionary. The additional building industry
dictionary has many such words and abbreviations that can be used in the text of a project and
therefore, you are not prompted for checking the spelling errors whenever such terms/words
appear in the text. You can also add or remove words from your personal and building industry
dictionary. To do so, choose the Edit button next to the option in the Additional Dictionaries area
to view the list of words and then enter or remove any word from the lists by using the cursor
and keyboard. To run spell check in your drawing, choose the Check Spelling tool from the
Text panel of the Annotation tab; the Spelling dialog box will be displayed, wherein you
can rectify spelling errors in the text by selecting the correct spelling and then choosing
the Change button in the dialog box. Alternatively, you can press the F7 key to display the
spelling dialog box.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Options ==

General Settings:
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User Interface
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ViewCube Autodesk Revit
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Building industry dictionary
C:\ProgramData Autodesk\RME 2015\RevitEMU. dic Edit. ..

[ ok ][ concel || Hebp |

Figure 2-23 The Options dialog box displaying the options in the Check Spelling tab
SteeringWheels Tab

The SteeringWheels tab in the Options dialog box has options to control the text
visibility, appearance of model, and behaviour of the operational tools of different types of
SteeringWheels. This tab has seven different areas, as shown in Figure 2-24. These areas are
discussed next.
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Options @

General Text Visibility

User Interf:
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Figure 2-24 The Options dialog box displaying the options in the SteeringWheels tab

Text Visibility Area

You can control the display of tool messages, tooltips, and tool cursor of SteeringWheels by
using the options in the Text Visibility area of the SteeringWheels tab. You need to select the
Show tool messages check box to enable the visibility of tool messages in SteeringWheels. To
display tooltips along with SteeringWheels, select the Show tooltips check box in this area.
Similarly, to control the display of the cursor text when a tool is active, select the Show tool
cursor text check box.

Big Steering Wheel Appearance and Mini Wheel Appearance Areas
The options in these areas are used to set the size and transparency of the SteeringWheels.
To set the size of SteeringWheels, select the required option from the Size drop-down list in
the corresponding areas and set its size to small, normal, or large. Similarly, you can set the
transparency of SteeringWheels by selecting the required option from the Opacity drop-down
list.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Look Tool Behavior and Walk Tool Areas
In the Look Tool Behavior area of the SteeringWheels tab, selecting the Invert Vertical Axis
check box enables the view to move in the same direction as does the cursor.

The Speed Factor slider in the Walk Tool area is used to change the walk speed while using
the Walk tool of the SteeringWheels. You can also select the Move parallel to ground plane
check box in the Walk Tool area to constrain the angular movement of the walk to ground
plane.

Zoom Tool and Orbit Tool Areas
Select the Zoom in one increment with each mouse click check box in the Zoom Tool area
to enable the zooming operation with a single click.

In the Orbit Tool area, select the Keep scene upright check box to maintain perpendicularity
between the sides of the model and the ground plane while using the Orbit tool.

ViewCube Tab

The ViewCube tab in the Options dialog box is used to edit the settings of the ViewCube. It has
four different areas: ViewCube Appearance, When Dragging the ViewCube, When Clicking
on the ViewCube, and Compass, as shown in Figure 2-25. These areas are discussed next.

ViewCube Appearance Area

This area is used to control the appearance and display of the ViewCube. In this area, the Show
the ViewCube check box is selected by default. As a result, the ViewCube will be visible. If you
clear this check box, the ViewCube will disappear and all options in the ViewCube tab will
be deactivated. In the ViewCube Appearance area, you can use the options from drop-down
lists to align, resize, and change the transparency of the ViewCube.

Select the options from the On-screen Position drop-down list to align the ViewCube on
the screen. Similarly, if you want to resize the ViewCube, select the required option from
the ViewCube size drop-down list. You can also set the opacity of the inactive ViewCube by
selecting an option from the Inactive Opacity drop-down list.

When Dragging the ViewCube Area
Select the Snap to closest view check box in this area to enable the snap to select the closest
view in the ViewCube.

When Clicking on the ViewCube Area

Select the Fit-to-view on view change check box in the When Clicking on the ViewCube
area to fit the view on the screen while changing the viewing direction. In this area, the
Use animated transition when switching views check box is selected by default. As a result,
the animated transition occurs while switching the views. Clear this check box if you do not
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want the animated transition. Select the Keep scene upright check box to keep the sides of
ViewCube and the sides of the view perpendicular to the ground plane. Clear the check box
to turn around the model in full 360-degree swing. Clearing this check box can be useful
when you are editing a family.

Options @
General ViewCube Appearance
User Interface
Graphics Show in [h]l 3D Views ']
File Locations On-screen position: [Top Right ']
Rendering ViewCube size: [hutomaﬁc "]
Check Spelliing Inactive opacity:  [50% -

SteeringWheels

ViewCube When Dragging the ViewCube

| Snap to dosest vi
Macros nap osest view

When Clicking on the ViewCube

Fit-to-view on view change

Use animated transition when switching views
Keep scene upright

Compass
Shaow the compass with the ViewCube (current project only)

o) Lo ] v ]

Figure 2-25 The Options dialog box displaying the options in the ViewCube tab

Compass Area

In this area, the Show the compass with the ViewCube check box is selected by default. As a
result, the compass along with the ViewCube is visible in the drawing. In the ViewCube tab,
you can choose the Restore Defaults button to restore the default settings that were changed
in its different areas.
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User Interface Tab

The User Interface tab contains the following areas: Configure and Tab Switching
Behavior. In the Configure area, you can specify the options for the display of Revit MEP user
interface. You can do so by selecting the Dark or Light option from the Active theme
drop-down list in this area. Also, you can choose the Customize button corresponding
to the Keyboard Shortcuts parameter to customize the use of shortcut keys in a project.
In the Configure area, you can select an option from the Tooltip assistance drop-down
list to set the extent of the tip that will displayed with the cursor when it is close to a tool.
The options in this drop-down list are None, Minimal, Normal, and High. By default,
the Normal option is selected in this drop-down list. Note that the tooltip will appear
more frequently in your drawing if you select High in the Tooltip assistance drop-down
list. In the Configure area, the Enable Recent Files page at startup check box is selected
by default. As a result, the recent files will be displayed on starting the Autodesk Revit MEP
software. You can clear this check box if you do not want to display the recent files at the
startup. In the Tab Switching Behavior area, you can specify the tab to be displayed once you
clear a selection or exit a tool. In this area, the Project environment drop-down list contains
two options: Stay on the Modify tab and Return to the previous tab. Select the Stay on the
Modify tab option to display the options in the Modify tab after exiting a tool or clearing a
selection. Alternatively, you can select the Return to the previous tab option to display the
last used tab after exiting a tool or clearing a selection. In the Tab Switching Behavior area,
the Display the contextual tab on selection check box is selected by default. As a result, the
contextual tab is displayed once you select a tool from the Autodesk Revit MEP interface.

CLOSING AN MEP PROJECT

To close a project, choose the Application button and then select the Close option from the
Application Menu displayed. If you have already saved the latest changes, the project file
will be closed. Otherwise, Revit MEP will prompt you to save the changes using the Save File
dialog box. You can save the changes by choosing the Yes button or discard them by choosing
the No button. You can also choose the Cancel button to return to the interface and continue
working on the project file. You can also use the Close button (X) in the drawing window to
close the project.

EXITING AN MEP PROJECT

To exit a Revit MEP session, choose the Exit Revit button from Application Menu. Even if
the project is open, you can choose the Exit Revit button to close the file and exit Revit MEP.
If the project has not been saved once, the Save File dialog box will be displayed on choosing
the Exit Revit button. In this dialog box, if you choose the No button, all unsaved changes
will be lost. You can also use the Close button (X) in the main Revit MEP window (in the title
bar) to end the Revit MEP session.
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OPENING AN EXISTING MEP PROJECT

In Autodesk Revit MEP, there are several options available to open an existing project. These
options are discussed next.

Opening an Existing Project Using the Open Tool

To open an existing project file, choose Open > Project from Application Menu. Alternatively,
you can open the project file by choosing the Open button from Quick Access Toolbar or
by pressing the CTRL+O keys. On invoking the Open tool, the Open dialog box will be
displayed, as shown in Figure 2-26. Using the Look in drop-down list in this dialog box, you
can access the desired folder and open the desired file.

The Preview area of the Open dialog box shows the preview of the selected project file. It
helps you select a particular file by viewing its contents even if you are not sure about the
name of the file. The window icons such as the Views menu, which is placed on the right
of the Look in drop-down list, helps you select a project file based on its size, type, or date
when it was last saved. On choosing the Thumbnails option from the Views menu, you can
preview the contents of the project files inside the selected folder in the file list area. In the
Open dialog box, you can browse to important locations from the Places list. The Places list
is located on the left side of the Open dialog box. In this list, you can add or remove folders
as per your requirement. To do so, choose the Options button from Application Menu; the
Options dialog box will be displayed. In this dialog box, choose the File Locations tab and
then the Places button from it; the Places dialog box will be displayed. The Places dialog
box contains two columns: Library Name and Library Path.

‘Open @
Look in: [ 2 v] 4= B ¥ O vews -

= Preview
+ | | Name Date modified Type

This folder is empty.

o | T | r

File name: -

Files of type: |All Supported Files (=.rvt, =.rfa, ®.adsk, =.rte, =.rft, “.rvt) -
Worksharing
[ Audit Detach from Central Create MNew Local [ Open ]B [ Cancel

Figure 2-26 The Open dialog box

You can add or remove folders in the libraries list to create a list of frequently accessed
folders. The four buttons on the left side of the Places dialog box can be used to create or
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delete a library, or move it up and down in the list. To create a new library, choose the Add
Value button, which is the third button from the top; a new library will be added to the
defined path. By default, the name of the new library in the Library Name section will be
NewLibraryl. Change the name of the new library and then click in the Library Path column
to display the Browse button. Choose the Browse button and select the folder to be added in
the libraries list by using the Browse for Folder dialog box. Next, choose the Open button;
the new folder will get added to the list. If required, choose the upward arrow button from
the Places dialog box to move the folder up to the top of the list. Similarly, you can choose
the down arrow button to move it down. To delete a library, select it and choose the Remove
Value button. Choose the OK button in the Places dialog box to exit, and then close the
Options dialog box. When you invoke the Open tool next time, the new folder icon will be
displayed in the places list.

Once the file to be opened has been selected, its name will be displayed in the File Name edit
box of the Open dialog box and its preview will be displayed in the Preview area.

Note
@ If you try opening an already opened file that has been modified in the Revit MEP session, a
message box will appear; prompting you to close the file first and then reopen it. In case you
open a file that has been created using an older version of Revit, the Program Upgrade
message box will be displayed. This message box informs that the file is being upgraded to the
latest file format and that this is a onetime process. Once the file is opened, it gets wpgraded
to Autodesk Revit MEP 2015 version.

Using the Windows Explorer to Open an Existing Project
Apart from using the Open tool from the Revit MEP interface to open a file, you can also open
files directly from the Windows Explorer by using the methods discussed next.

A file can be opened by double-clicking on its icon in the Windows Explorer. It opens the
project file in the latest Revit MEP session. If Revit MEP is not running, double-click on the
file icon to start Revit MEP and then open the file.

Another method of opening a project file is by dragging the project file icon from the Windows
Explorer and dropping it in the drawing window of the Revit MEP interface. You can also
select, drag, and drop more than one file in the drawing window. In this case, Revit MEP
prompts you to open the files in separate windows. Choose the OK button to open all files in
the same Revit MEP session.
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TUTORIAL

Tutorial 1 Office Space
In this tutorial, you will create a project setup for the Office-Space project using the following
parameters and project specifications: (Expected time: 45 min)

1. Template file:

For Imperial ~ US Imperial > Systems-Default

For Metric US Metric > Systems-Default_Metric
2. Project Units: Refer to Figure 2-29
3. File name to be assigned:

For Imperial  c02_Office-Space_tutl.rvt

For Metric M_c02_Office-Space_tutl.rvt

The following steps are required to complete this tutorial:

Start a Revit MEP 2015 session.

Use Systems-Default (Imperial) or Systems-Default_Metric (Metric) as the template file
for the project, refer to Figure 2-27.

Specify the Project Units, refer to Figure 2-29.

Specify the project information, refer to Figure 2-30.

Create the Project Parameter, refer to Figure 2-31.

Add the Project Parameter to Project Information.

Set the Project Location.

Set the Browser Organization.

Save the project as c02_Office-Space_tutl.rvt by using the Save As tool.
Close the project by using the Close tool.

o e

TrrDigg Mo a0

Starting Autodesk Revit MEP 2015

1. Start Autodesk Revit MEP 2015 by choosing Start > All Programs > Autodesk > Revit
MEP 2015 > Revit MEP 2015 from the taskbar. On doing so, the Revit MEP interface
window is displayed.

Opening a New Project
1. Click on the Application button; the Application Menu is displayed. Choose New > Project
from this menu; the New Project dialog box is displayed, as shown in Figure 2-27.
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Mew Project @
Template file
[MedﬂaniczITemplahe v] ’ Browse. .. l
Create new
@) Project ) Project template
| oK || cancel ||  Hep |

Figure 2-27 The New Project dialog box

Selecting the Template File
To select the template file for the project, you need to access the appropriate folder and select
the required template file from it.

1.

In the New Project dialog box, choose the Browse button from the Template file area; the
Choose Template dialog box is displayed with a list of template files in the US Imperial
folder. Note that for Metric system, the dialog box will display a list of template files in
the US Metric folder.

In the Choose Template dialog box, select the Systems-Default template file from the list,
as shown in Figure 2-28. For Metric system, select the Systems-Default_Metric template
file from the list. Choose the Open button to assign the selected template file to the New
Project dialog box.

In the New Project dialog box, ensure that the Systems-Default.rte (for Metric system
Systems-Default_Metric.rte) option is selected in the drop-down list located in the
Template file area and the Project radio button is selected in the Create new area. Now,
choose the OK button; the New Project dialog box is closed and the Systems-Default.rte
template file is loaded in the current file. (For Metric system the Systems-Default_Metric.rte)
is loaded in the current file. Notice that the Project Browser now shows different levels
and views that have already been created in the selected template file.
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Choose Template [
:[],USI.rnperiaJ v]ﬁgxm Views
- . Preview
Mame Date modified Type
Electri cal-Default 172472014 1048 PM Autodesk Revi °
Mechanical-DefauIt 172472014 1048 PM Autodesk Revi
PIumbing-DefauH: 1/24/2014 10:48 PM  Autodesk Revi = a
{am Systems Defauit 172473014 10:48 PM_ Autodesk Revi
be
- L]
i
a
My Computer
< m D
File name: Systems-Default -
Files of type: [TeranahE Files (*.rte) ']

Figure 2-28 The Choose Template dialog box

Setting the MEP Units

1. o set units for the MEP project, choose the Project Units tool from the Settings panel
of the Manage tab; the Project Units dialog box is displayed.

2. In the Project Units dialog box, select the HVAC option from the Discipline drop-down
list; the various units required in the HVAC workflow are displayed in a table located below
the Discipline drop-down list, refer to Figure 2-29.

3. Next, choose the button in the Format column corresponding to the Density parameter;
the Format dialog box is displayed.

4. In the Format dialog box, select the Pounds per cubic inch option (For Metric system
select the kilograms per cubic meter option) from the Units drop-down list and then
choose the OK button; the Format dialog box is closed.
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Project Units =
Discipline: HVALC - ]
Units Format &
Density 11234.5670 Ib/ft.| 4
Friction 1234.57 in-wq/100ft
Power 1235 Btu/h
Power Density LB“AL.E_; Wit
Pressure 123457 in-wg
Temperature 1235 °F
Velocity 1230 FPM
Air Flow 1235 CFM
Duct Size - VA
Cross Section 123457 in”
Heat Gain 12346 Btu/h
Roughness 12345679
Viscosity 1234.57 cP
Air Flow Density 1234.57 CFM/SF il
Decimal symbol/digit grouping:
[ 123,456, 789.00 -
[ Ok ] [ Cancel ] ’ Help ]

Figure 2-29 Tuble in the Project Units dialog box displaying
various units required in the HVAC workflow

5. In the Project Units dialog box repeat steps 2 to 4 and assign different units for the
Electrical, Piping, and Energy disciplines. Refer to the table given next for the formats
and the discipline of different units needed to be specified.

Discipline Unit Format (Imperial) | Format (Metric)
HVAC Pressure Pounds per square | Pascals
inch
Electrical [luminance Footcandles Lux
Electrical Apparent Power [ BTU Watts

(British Thermal
Units) per seconds

Pipin Densit Pounds per cubic | kilograms per cubic
png y P g p
inch meter
Energy Coefficientof Heat | BT U (British |[Watts per square
Transfer Thermal Units) per [ meter kelvin

hour square foot
degree Farenheit

6. In the Project Units dialog box, after specifying the various formats for different units,
choose the OK button; the Project Units dialog box is closed.
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Setting the Project Information

In this section, you will add the project information to the Office-Space project file.

1.

4.

To set the project information, choose the Project Information tool from the Settings

panel of the Manage tab; the Project Properties dialog box is displayed.

In the Project Properties dialog box, specify the project parameters as given in

Figure 2-30.

Parameter

Value |

Identity Data

Organization Mame

7

CADCIM Tech. USA

Organization Description

Publishing, Training, and Consulting

Building MName CT-525

Author Prof. Sham Tickoo

Energy Analysis : 2
Energy Settings { Edit... I
Other H
Project Issue Date 1/3/2014

Project Status Started

Client Mame Sham Tickoo

Project Address [ Edit...

Project Name TIET-Main Campus

Project Number TIET/01/2014

Figure 2-30 Tarious project parameters specified in the Project Properties dialog box

In the Project Properties dialog box, choose the Edit button displayed in the Value
field corresponding to the Energy Settings parameter; the Energy Settings dialog box
is displayed. In this dialog box, change the parameters as shown in the table given next

and retain the other settings.

Parameter Value

Export Category Spaces
Building Infiltration Class Tight

Report Type Detailed
Building Service VAV-Dual Duct
Sliver Space Tolerance 1'3” (381 mm)

Export Complexity

Complex with Shading Surfaces

Building Operating Schedule

24/7 Facility

HVAC System

Central VAV, HW Heat, Chiller 5.96 COP,
Boilers 84.5 eff

In the Energy Settings dialog box, choose the OK button; the dialog box closes and the
specified values are assigned to the Energy Settings parameter in the Project Properties

dialog box.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-46 Exploring Autodesk Revit MEP

5. In the Project Properties dialog box, choose the OK button; the dialog box is closed.

Creating the Project Parameter
In this section, you will create a shared project parameter to be added in the project
information.

1. Choose the Shared Parameters tool from the Settings panel of the Manage tab; the Edit
Shared Parameters dialog box is displayed, as shown in Figure 2-31.

Edit Shared Parameters (23]

Shared parameter file:

D:‘l,DFﬁce—SpaceWEP‘l,CarbonFooiprint.tE Browse. .. il Create... ]

Parameter group:
[ ™

Parameters:

Parameters

Properties...
Move...
Delete

Groups

Rename...

Delete

l QK ] l Cancel ] l Help ]

Figure 2-31 The Edit Shared Parameters dialog box

2. In the Edit Shared Parameters dialog box, choose the Create button; the Create Shared
Parameter File dialog box is displayed.

3. Inthe Create Shared Parameter File dialog box, create a folders as per the following path
C:\Office-Space\MEP.

4. Browse to the MEP folder and then enter the Carbon Footprint text in the File name
edit box and then choose the Save button; the dialog box closes and the Edit Shared
Parameters dialog box is displayed again.

5. In this dialog box, choose the New button in the Groups area; the New Parameter Group
dialog box is displayed.

6. In the displayed dialog box, enter the Green House Gas text in the Name edit box and
then choose the OK button; the New Parameter Group dialog box is closed and the new
group is displayed in the Parameter group drop-down list of the Edit Shared Parameters
dialog box.
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10.

Now, choose the New button in the Parameters area; the Parameter Properties dialog
box is displayed.

In this dialog box, enter the Carbon Footprint Factor text in the Name edit box and then
select the Energy option from the Discipline and Type of Parameter drop-down lists.

Now, in the Parameter Properties dialog box, choose the OK button; the dialog box is
closed and the Edit Shared Parameters dialog box is displayed with the new parameter
added.

In the Edit Shared Parameters dialog box, choose the OK button; the displayed dialog
box is closed.

Adding the Project Parameter to Project Information
In this section, you will add the project parameter to the project information.

1.

Choose the Project Parameters tool from the Settings panel of the Manage tab; the Project
Parameters dialog box is displayed.

In the Project Parameters dialog box, choose the Add button; the Parameter Properties
dialog box is displayed.

In the Parameter Type area of the Parameter Properties dialog box select the Shared
parameter radio button and then choose the Select button; the Shared Parameters dialog
box is displayed.

In this dialog box, ensure that the Carbon Footprint Factor parameter is selected in the
Parameters area and then choose the OK button; the Shared Parameters dialog box is
closed.

In the Parameter Data area of the Parameter Properties dialog box, ensure that the
Instance and the Values are aligned per group type radio buttons are selected. Also,
ensure that the Energy Analysis option is selected from the Group parameter under
drop-down list.

In the Categories area, select the Project Information check box from the list box
displaying all categories.

Now, choose the OK button; the Project Parameters dialog box is displayed. Choose the
OK button in the displayed dialog box to close it.

After assigning the shared parameter to the category of project information, now you need to
specify a value to the added parameter in the Project Properties dialog box.

8.

Choose the Project Information tool from the Settings panel of the Manage tab; the
Project Properties dialog box is displayed.
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9.

In the Project Properties dialog box, click in the Value field corresponding to the Carbon
Footprint Factor parameter and enter 12,000 in it.

10. Next, choose the OK button to close the Project Properties dialog box.

Setting the Project Location
In this section, you will set the location of the project.

1.

Choose the Location tool from the Project Location panel of the Manage tab; the Location
Weather and Site dialog box is displayed.

In this dialog box, ensure that the Location tab is chosen by default. Now select the
Internet Mapping Service option from the Define Location by drop-down list, if it is not
selected by default.

Note

On selecting the Internet Mapping Service option from the Define Location by drop-down
list, the Google Map browser is activated for browsing the desired location. You should ensure
that the internet connection is active at this stage.

In the Location tab of the Location Weather and Site dialog box, enter Schererville,
IN in the Project Address edit box and then choose the Search button; the Google Map
browser displayed under the Project Address edit box shows the desired location in the
map, as shown in Figure 2-32.

Location Weather and Site @

Location | weather | Site

Define Location by:

[?_Intemet Mapping Service v]

Project Address:

Schererville, IM, USA A

- \ | Mmap Satellite Hybrid | Terrain |
t [
[y

Project Addre=ss: Schererville, IN, USA Ind
Latitude: 41.4789246
Longitude: -87.4547605

[ K, ][ Cancel ][ Help ]

Figure 2-32 The Location Weather and Site dialog box

4. Now, choose the OK button to close the Location Weather and Site dialog box.
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Setting the Browser Organization
In this section, you will set the Project Browser to display various views and information
related to the project in the order of their discipline.

1.

Choose the Browser Organization tool from View > Windows > User Interface
drop-down; the Browser Organization dialog box is displayed.

In the displayed dialog box, ensure that the Views tab is chosen by default and then
choose the New button; the Create New Browser Organization dialog box is displayed.

In the Name edit box of the displayed dialog box, enter Office-Space-MEP and then
choose the OK button; the dialog box closes and the Browser Organization Properties
dialog box is displayed.

In this dialog box, choose the Grouping and Sorting tab; various options in this tab are
displayed.

Select the Discipline option from the Group by drop-down list.

Ensure that the All characters radio button located under the Group by drop-down list,
is selected. Now, select the Family and Type option from the Then by drop-down list.

Next, select the View Name option from the Sort by drop-down list located at the bottom
in the Browser Organization Properties dialog box. Ensure that the Ascending radio
button located below the Sort by drop-down list is selected.

Choose the OK button; the Browser Organization Properties dialog box is closed.
In the View tab of the Browser Organization dialog box, select the Office-Space-MEP

check box. Now, choose the Apply button and then the OK button; the dialog box is closed
and the specified settings are applied to the Project Browser, refer to Figure 2-33.

Saving the Project

In this section, you need to save the project and the settings using the Save As tool.

1.

To save the project with the settings, choose Save As > Project from the Application
Menu; the Save As dialog box is displayed.

In this dialog box, browse to the € drive and then create a folder with the name
rmp_2015 and then create a sub-folder with the name c02.

In the File name edit box, enter c02_Office-Space_tutl for Imperial or
M_c02_Office-Space_tutl for Metric and then choose the Options button; the File Save
Options dialog box is displayed.

In this dialog box, enter 5 in the Maximum backups edit box, and then in the Thumbnail
Preview area select the 3D View option from the Source drop-down list.
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Figure 2-33 The Project Browser displaying the seitings specified in

the Office-Space-MEP browser organization

5. In this dialog box, select the Regenerate if view/sheet is not up-to-date check box.

6 Now, choose the OK button; the File Save Options dialog box is closed and the Save As

dialog box is displayed.

7. In this dialog box choose the Save button to save the current project file with the specified
name and to close the Save As dialog box.

Closing the Project

1. To close the project, choose the Close option from the Application Menu.

The file is closed and this completes the tutorial.
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Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. You can open multiple Revit MEP project at a time. (T/F)

2. In Revit MEP, you can enable all the object snap options at a time. (T/F)

3. The extension of a template file used in a Revit project is .rft. (T/F)

4. The Options dialog box is used to configure the global settings of the project. (T/F)
5. The tool can be used to set the disciplines in the Project Browser.

6. You can define the geographical location of a project by using the tool.

7. In an MEP project you can inherit the project standard from another Revit project by
using the tool.

8. The button in the Save As dialog box can be used to specify the maximum
numbers of backup(s) for a project file.

9. The options in the tab of the Options dialog box can be used set the path for
various frequently accessed files and directories.

10. You can choose the Link Revit tool from the tab to link a Revit project to the
current project.

11. Which of the following tabs in the Options dialog box you can use to set the configuration
of the fabrication application?

a) User Interface b)File Locations
¢) General d) None of these

12. Which of the following tools can be used to set the Project Browser of a project?

a) Keyboard Shortcuts b) Project Browser
c) Object Styles d) Browser Organization
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Review Questions

Answer the following questions:

1.
2.

10.

In Revit MEP, you can create a unique identification for a particular session. (1/F)

The flow in the piping system implies to the discharge rate of the water or fluids. (1/F)
You cannot control the visibility of an element in the linked model(s). (T/F)

The Save reminder interval drop-down list available in the General tab of the Options
dialog box is used to specify the time interval between reminder prompts to save a project

file. (T/F)

If you choose the Close button without saving the changes made in a project file, Revit
MEP will prompt you to save the changes before closing it. (T/F).

You can specify the settings for ViewCube and SteeringWheels in the
dialog box.

The tool can be used to share the coordinates of the host model with the
linked model.

Which of the following files are used to resolve technical problems occurred during the
Revit MEP session?

a) Temporary b) History
¢) Journal d) Cookies

Which of the following options is not an object snap option?

a) Endpoints b) Work Plane Grid
¢) Dimension d) Centers

Which of the following keys is used to toggle between the object snap options available at
the same point?

a) TAB b) CTRL
¢) ALT d) F3
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Exercise 1

Power Plant

In this exercise, you will create a new project file for the Power Plant project with the following

parameters.

1.

Template file:
For Imperial
For Metric

Project information to be added:

Project Issue Date
Project Status
Client Name
MEP Consultant

Mechanical Consultant

Project Name
Commencement Date

Documented Contract Completion Date
Provisional Period Allowed in Contract

(Expected time: 15 min)

US Imperial > Systems-Default
US Metric > Systems-Default_Metric

10/05/2014
Started

CADCIM Technologies
CADCIM-Technologies

Sham Tickoo
Power Plant
20/09/2014
31/07/2015
30 Days

3. Project Units- Set the various units in Power Plant project as shown in table given next.

Discipline Units Format (Imperial) | Format (Metric)
HVAC Power Kilowatts Kilowatts
HVAC Heat Gain Kilowatts Kilowatts
HVAC Duct Size Decimal inches Millimeters
HVAC Factor Fixed Fixed
HVAC Pressure Pounds per square | Pascals
inches

Electrical Frequency Cycles per second | Cycles per second
Electrical Current Kiloamperes Kiloamperes
Electrical Illuminance Footcandles Lux
Electrical Electrical Potential | Kilovolts Kilovolts
Piping Velocity Feet per second Meters per second
Energy Coefficient of Heat | BTU per hour Joules

Transfer

4. Energy Settings-Set it as specified in table given next.
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Parameter Value
Export Category Spaces
Building Infiltration Class Tight
Project Phase Existing
Location Texas, USA

Building Services

Fan Coil System

Report Type

Simple

Sliver Space Tolerance

1’57 (432 mm)

Export Complexity

Complex with Shading Surfaces

Building Operating Schedule

24/7 Facility

HVAC System

Central VAV, HW Heat, Chiller 5.96 COP,
Boilers 84.5 eff

5. File name to be assigned:

For Imperial ~ ¢02_Power_Plant_exerl.rut
For Metric M _c02_Power_Plant_exerl.rut

Answers to Self-Evaluation Test

1. T, 2. T, 3. F, 4. T, 5. Browser Organization, 6. Location, 7. Transfer Project Standards,
8. Options, 9. File Locations, 10. Insert 11. d 12. d



